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1 About this manual
Welcome to Telelogic® DOORS® 9.1, a powerful tool that helps you to capture, 
track and manage your user requirements.
This manual describes how to integrate Telelogic DOORS (DOORS) with other 
applications. It describes how you can create links between DOORS and external 
tools; it focuses on the overall strategy for creating tool interfaces.
This manual assumes that you know how to program in C and DXL (DOORS 
eXtension Language).

Typographical conventions
The following typographical conventions are used in this manual:

Each function or macro is first introduced by name, followed by a declaration or 
the syntax, and a short description of the operation it performs. These are 
supplemented by brief examples where appropriate.
In declarations and syntax, parentheses (()) are literal language elements, square 
brackets ([]) enclose optional items; braces ({}) enclose alternatives, which are 
separated by pipe symbols (|); and ellipsis (...) indicate that arguments can be 
repeated. Where square brackets or pipe symbols form part of the syntax they 
are shown in bold.

Typeface or 
Symbol

Meaning

Bold Important items, and items that you can select, including 
buttons and menus. For example: Click Yes to continue.

Italics Book titles

Courier Commands, files, and directories; computer output. For 
example: Edit your .properties file.

> A menu choice. For example: Select File > Open. This means 
select the File menu, then select the Open command from it.
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Terminology
The following terminology is used in this manual:

Related Documentation
The following table describes where to find information in the documentation 
set:

Term Description

API Application Programming Interface. Normally a set of 
functions and data structure declarations provided by an 
application program as a means of making its facilities and 
data available to other programs. In the context of DOORS, 
DXL can often be used to do the tasks for which other tools 
would need an object library type interface. For tighter 
integration, DOORS also supplies a C-based API to create a 
DXL like layer around the target tool.

DOORS C API An API written in C which enables a C program to make its 
own DXL like language or communicate with DOORS using 
IPC.

DXL DOORS eXtension Language

IPC Inter Process Communication. A system of message passing 
between processes, such as between DOORS and a CASE 
tool.

TDS Toy Database Server; An example C-based API provided to 
illustrate the use of the DOORS C API in linking external 
tools to DOORS.

For information on See

What’s new in version 9.1 of DOORS The Telelogic DOORS readme file

How to install DOORS Telelogic DOORS Installation Guide

How to set up licenses to use DOORS Telelogic Lifecycle Solutions Licensing 
Guide
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Related Documentation

You’ll find PDF versions of these manuals on:

• The Telelogic Lifecycle Solutions DVD

• The support website at https://support.telelogic.com

How to use DOORS Getting Started with Telelogic DOORS
Using Telelogic DOORS

How to write requirements Get it Right the First Time

How to set up and manage DOORS Managing Telelogic DOORS

The DXL programming language DXL Reference Manual

How to integrate DOORS with other 
applications

Telelogic DOORS API Manual

For information on See
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2 Introduction
This chapter outlines how DXL can be used to link DOORS with external tools. 
It contains the following topics:

• DOORS APIs

• DOORS and external data

• Strings

DOORS APIs
DOORS provides application programming interfaces (APIs) for extending 
capability, customizing, and linking to other tools. The main interface is the 
DOORS eXtension Language (DXL).
DXL provides a comprehensive set of facilities for making links between 
DOORS and external applications, such as CASE tools or configuration 
management databases. Links can range from simple file format import or 
export, through to complex manipulations of externally managed data using 
interprocess communication (IPC). For example:

• DXL can be used to convert DOORS data into the file format accepted by a 
user’s word processor.

• A two way interactive link can be established between a set of DOORS 
requirements and their realization in a CASE tool database.

The DOORS C API supports multi-platform tool integrations requiring IPC. It 
also supports the creation of languages like DXL for the tool being linked to.
For integrations that are to run only on Windows® platforms, DXL supports 
OLE automation, both as a client and a server application.
File format import or export can be accomplished with a moderate level of 
programming experience. The DXL server can be used by anyone able to 
understand simple DXL commands. OLE automation can be used by those with 
moderate knowledge of DXL and Visual Basic. Complex tool linkage requires 
both competence in the interfacing facilities provided by the target system and 
an understanding of the facilities of the DOORS C API.
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DOORS and external data
DOORS can read and write several commonly used file formats, for example, 
FrameMaker and Rich Text Format (RTF). However, it is impossible to 
anticipate and support every file format that might be used. 
Therefore, the facilities DOORS uses for file import and export are available to 
the user; you access them through DXL.
Importing and exporting files is a task whose complexity depends on the 
complexity of the input format to be parsed. If you already have a parser, you can 
extend its capability using the techniques described in “Using the DXL server,” 
on page 17 and “Interactive interfacing with a complex external tool,” on page 
27.
When developing translation programs, you can use the DOORS source code as 
a starting point. The code is in:

$DOORSHOME/lib/dxl/standard/import

and
$DOORSHOME/lib/dxl/standard/export

Strings
An important aspect of building a successful DXL application, such as an 
importer, is string handling. DOORS has an internal data structure, called the 
string table, which stores single copies of ASCII strings used in DOORS. Any 
string created by a DXL program resides in the string table for the duration of 
the current DOORS session. You should therefore avoid constructs like:

line = line ch ""

where line is a string being constructed out of individual characters ch. This is 
a very inefficient construct because every temporary value stored in line is made 
persistent in the string table.
Instead of concatenating characters into a string variable, you should use the 
Buffer data type because buffers do not consume string table space, for 
example:

Buffer Buf
Buf += ch
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3 The DOORS C API
This chapter describes the DOORS C API. A series of macros and functions 
allow you to perform integration tasks like those in this manual. Refer also, to the 
file $DOORSHOME/include/doors/ api.h. 
This chapter contains the following topics:

• About the API

• Object and library files

• Extending the DOORS C API

• DOORS C API entry points

About the API
The DOORS C API allows you to create a language like DXL around an existing 
tool. It also provides the inter-process communication facilities needed to 
establish a link with DOORS.

Object and library files
The UNIX® object file for the DOORS C API is in $DOORSHOME/lib/api.o.
The following library files are necessary on Win32 platforms:

$DOORSHOME/bin/dxlapi.dll
$DOORSHOME/bin/dxlapi.lib

The .lib file is required by the client C application at link time, while the .dll file 
must be on the path of the client application at run time.

Extending the DOORS C API
This section defines the macros used to extend the DOORS C API interpreter 
with new functions and data types to create a language like DXL.

New DXL types
When you extend the core DXL language with new operations, you often need 
new data types which can be passed to the C functions that implement the 
operations on them. You define new data types using the struct facility, for 
example:

struct Table {}
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This declaration introduces the new type Table.
Introducing new data types is the only valid use of the keyword struct.

apiInstall

Syntax
apiInstall(proto, 
           fn)

Operation

Registers a new function with the API’s interpreter. The argument proto is a 
string containing a valid DXL function prototype, for example:

"void create(string)"

The argument fn is the name of a C function.
The interpreter calls fn when the function in proto is executed. The C function 
fn must be declared using BEGIN_FN, END_DECLS, and END_FUNCTION.
When used to install a for loop, proto must be in the form:

void ::do(elementType&, 
          parentType, 
          void)

BEGIN_FN

Syntax
BEGIN_FN(fn, 
         ins, 
         outs)

Operation

Starts a function declaration. The argument fn is the name of the function being 
declared; it must be the same as the fn argument passed to the corresponding 
call to the apiInstall function.
The argument ins is the number of input parameters allocated to the DXL 
function prototype by the corresponding call to apiInstall.
The argument outs is the return type allocated to the DXL function prototype 
by the corresponding call to apiInstall. The values can be 0 for a void 
function, or 1 for all other return types.
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P_

Syntax
P_(type, 
  var)

Operation

Declares a parameter that is accessible with a function declared by BEGIN_FN and 
END_FN.
The parameter type is the type of the parameter. The parameter var is the 
variable name of the parameter.
Parameters and variables manipulated by the DXL interpreter must be no larger 
than a C type long or pointer (whichever is larger). For further information on 
DXL interpreter data, see “DXL API integration features,” on page 21.

END_DECLS

Syntax
END_DECLS

Operation
Ends declarations of parameters using P_, and other declarations of local variables after a call to BEGIN_FN.

RETURN_

Syntax
RETURN_(value)

Operation

Sets the return value after a call to BEGIN_FN. The parameter value is the value 
to be returned from the function declared using BEGIN_FN and END_FN.

END_FN

Syntax
END_FN

Operation

Ends a function declaration started by BEGIN_FN.
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BEGIN_FOR_DO

Syntax
BEGIN_FOR_DO(name, 
             pt, 
             p, 
             et, 
             scan)

Operation

Starts the declaration of a for..do loop, corresponding to the loop installed by 
the apiInstall function.
The argument name is the name of the loop. The argument pt is the type of the 
parent of the loop. The argument p is a variable that stores the parent. The 
argument et is the type of the elements to be scanned. The argument scan is a 
variable that holds each scanned element in turn.

PROCESS_DO

Syntax
PROCESS_DO(scan)

Operation

Continues a BEGIN_FOR_DO declaration.
The argument scan must be the variable passed to BEGIN_FOR_DO as scan.

END_FOR_DO

Syntax
END_FOR_DO

Operation

Completes a BEGIN_FOR_DO declaration.

Example

This example extends the DOORS C API for a new language, TXL. It declares a 
function tdsCreate, which appears as create in a TXL script. It takes a TXL 
string parameter (a char* in C) and returns a TXL Table value (a Table* in C).

apiInstall("void create(string)",tdsCreate)



Telelogic DOORS API Manual           11

DOORS C API entry points

BEGIN_FN(tdsCreateFn,1,1)  
    P_(char*,name);  
    Table* tab;  
    END_DECLS;  
    tab = tdsCreate(name);  
    RETURN_(tab);  
END_FN

This example creates a for..do loop. Entry is the TXL data type representing a 
C Entry* variable, and is the type of the scan variable. Table is the TXL data 
type representing a C Table* variable, and is the parent of the scan.

BEGIN_FOR_DO(tdsDoFn,Table*,tab,Entry*,scan) 
    tdsDo(tab,scan) { 
      PROCESS_DO(scan); 
    } 
END_FOR_DO
apiInstall("void ::do(Entry&, Table, void)",  
             tdsDoFn);

Given these declarations you can run the TXL script:
Table tab = create "my table"
tab["1"] = "one"
Entry e
for e in tab do { 
    print (key e) "\n" 
}

The PROCESS_DO macro causes the code:
print (key e) "\n"

to be executed for each Entry e. The code:
tdsDo(tab,scan)

of tdsDoFn, causes scan to be set to each Entry* in tab, which in turn appears 
as e in the TXL script.

DOORS C API entry points
In the entry points that follow, the parameters of external function declarations 
are shown within #if and #endif statements.

apiError
extern void apiError();
#if 0  
    char *format; 
    ... 
#endif
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Causes the calling program to exit and issue an error message. The parameter 
format is a printf style format. If only one parameter is used, the character % 
must appear as %%.

apiWarn
extern void apiWarn(); 
#if 0  
    char *format; 
    ... 
#endif

Issues a warning message. The parameter format is a printf style format. If 
only one parameter is used, the character % must appear as %%.

apiMainProg
extern void apiMainProg(); 
#if 0  
   int argc;  
   char* argv[];  
   char* name;  
   char* ext;  
   char* include;  
   void (*init)();  
   void (*done)();  
#endif

Sets up a DOORS active link main program.
The arguments argc and argv are the normal C main program parameters.
The argument name is the name of the resulting language (for example, TXL). A 
null value causes the default core DXL Interpreter (CDI) to be used.
The argument ext is the file extension used by scripts (for example, .txl). A 
null value causes the default, .cdi, to be used.
The argument include is a separate path of places to search for source and 
include files. A null value defaults to the current directory.
The function init should contain all the initialization needed for the server.
The function done should do all the final winding down for the server.

apiInitLibrary
extern void apiInitLibrary(); 
#if 0  
   char* n;  
   char* ext;  
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   char* include;  
#endif

Initializes the API when apiMainProg is not being used. The parameters are as 
described in apiMainProg.

apiFinishLibrary
extern void apiFinishLibrary();
#if 0 
#endif

Winds down the API.

apiParse
extern void apiParse(); 
#if 0  
    char *format; 
    ... 
#endif

Parses and executes the parameters in the API’s interpreter. The parameter 
format is a printf style format. If only one parameter is used, the character % 
must appear as %%.
For examples of the use of apiParse, see “Listing of tds.c,” on page 49.

apiConnect
extern void apiConnect();
#if 0  
    char *s;  
#endif

Used only by clients of a UNIX DXL server to make a connection to it.
The argument s is the name of the UNIX file socket to use.

apiConnectSock
extern void apiConnectSock();
#if 0  
    unsigned short portNum;  
    char* hostAddr; 
#endif

As apiConnect uses a TCP/IP address for the socket; it is available on UNIX 
and Win32 platforms.
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apiSend
extern void apiSend(); 
#if 0  
    char *format; 
    ... 
#endif

Sends the specified string down the connection made with apiParse or 
apiConnectSock as a DXL script to be executed by DOORS. The parameter 
format is a printf style format. If only one parameter is used, the character % 
must appear as %%.
A subsequent call to replyAPI, causes apiSend to execute the string passed to 
replyAPI using the API’s interpreter.

apiSendTimesout 
extern void apiSendTimesout(); 
#if 0  
    int tmt; 
    char *format; 
    ... 
#endif

Like apiSend, but the tmt parameter is the number of seconds it waits for the 
reply. The parameter format is a printf style format. If only one parameter is 
used, the character % must appear as %%.

apiSendFile
extern void apiSendFile(); 
#if 0  
   char *f;  
#endif

A file variant of apiSend, which sends the file pointed to by f as a DXL script to 
be executed by DOORS.

apiExitOnError
extern void apiExitOnError()
#if 0  
   int onOff; 
#endif

Sets whether the API functions exit whenever there is an error. By default, the 
functions exit, but you can prevent that using this function.
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apiQuietError
extern void apiQuietError()
#if 0  
   int onOff; 
#endif

Sets whether the API functions produce error messages on the command line. 
By default, the functions produce command line error messages, but you can 
prevent that using this function.

apiGetErrorState
extern int apiGetErrorState()
#if 0  
#endif

Returns the error that occurred most recently. Possible return values are:
DOORS_API_OK 
DOORS_API_PARSE_BAD_DXL 
DOORS_API_SEND_BAD_DXL 
DOORS_API_CONNECT_FAILED 
DOORS_API_ERROR

apiGetIPC
extern void *apiGetIPC()
#if 0  
#endif

Returns a pointer to the IPC channel currently being used by the API.

apiSetIPC
extern int apiSetIPC()
#if 0  
   void *newIPC; 
#endif

Sets the IPC channel for use by the API. Returns 1 if newIPC was set; otherwise, 
returns 0. Returns 0 if newIPC is null or not connected.

apiDeleteIPC
extern void apiDeleteIPC()
#if 0  
   void *IPC; 
#endif

Deletes the specified IPC channel.
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4 Using the DXL server
This chapter describes how to use the DXL server, which allows external 
applications to send DXL programs to DOORS for execution. It contains the 
following topics:

• About the DXL server interface

• Using the DXL server in batch mode

About the DXL server interface
The DXL server allows programs external to DOORS to send DXL messages to 
DOORS for execution. For example, a Windows Command prompt, a UNIX 
shell or tools with shell escape facilities, could send messages to DOORS.
The DXL server interface consists of three programs: 

dxlfile
dxlips
dxlipf

On UNIX platforms, all three are available.
On Windows platforms, only dxlips and dxlipf are provided. The programs 
differ in the mechanism used to communicate with DOORS: dxlips and 
dxlipf use TCP/IP port and host sockets to connect to DOORS; dxlfile uses 
UNIX file system sockets. 

Note  The DXL server can only be launched from an interactive 
DOORS session. It is not supported from batch DXL 
programs. The behavior of the DXL server can be emulated 
from batch DXL using the DXL program described later in 
this chapter.

If an external tool allows commands to be invoked from within its user interface, 
these programs can be used to communicate with DOORS. An example of such 
an external tool is a CASE tool that has a user-defined menu.
Rewrite these programs for your own tool.

Starting the server

On all platforms, executing the following DXL from the DXL Interaction 
window starts the TCP/IP server on port 5093 (the default port):

evalTop_ "initDXLServer server 5093"
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Alternatively, the line:
initDXLServer server 5093

could be included in startup.dxl.

Note  In practice, do not hard code port numbers. Instead make 
sure that they can be configured by the user.

After initializing the server, you can use the server interface commands. This 
level of tool integration does not directly support receiving replies from 
DOORS.
The commands dxlips, dxlfile, and dxlipf are simple utilities that use the 
DOORS C API facilities described in “The DOORS C API,” on page 7. The 
source code is supplied in $DOORSHOME/api.

dxlips

The program dxlips is supplied with DOORS in $DOORSHOME/bin and runs on 
UNIX and Win32 platforms.
It takes a single string command-line argument, which is sent to DOORS and 
interpreted as a DXL program.
DOORS and dxlips can be run on different machines. They communicate 
through a TCP/IP socket with a default port number given by the environment 
variable DXLPORTNO on a host indicated by DXLIPHOST. The server always runs 
on the same host as DOORS.

Example

This example of dxlips causes the date on which the current DOORS session 
started to be printed in the DOORS DXL Interaction window’s output pane.

%DOORSHOME%\bin\dxlips "print session"

dxlfile and dxlipf
The programs dxlfile and dxlipf operate in the same way as dxlips, except 
that the command-line argument specifies the name of a file which contains a 
DXL program to be sent to DOORS.

system

DOORS allows external tools to be called using the DXL command system, 
which is described fully in the DXL Reference Manual.
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Using on UNIX platforms
void test (int status) { 
    print "ls finished with status " status ""  
}
system("ls", test)

A particularly useful feature of the DXL system command on UNIX platforms 
is that a callback function is called (test in the example above). 
When the external command completes, it permits operations such as reading 
temporary files generated by the system call. 

Using on Windows platforms
system("C:\winnt\system32\command /c dir") 

On Windows platforms you can call the system command several times in the 
same script. Each time it is called a new process is forked to run the command. 
If you run more than twenty processes, the behavior is undefined. To avoid this, 
ensure that each group of fewer than twenty system commands has adequate 
time to complete before you move on to the next group.
One way to do this is to place an ack command between each group of calls.

Using the DXL server in batch mode
DOORS has two modes of operation: interactive mode, where there is a 
graphical user interface, and batch mode where DOORS runs with no graphical 
user interface. 
To run DOORS in batch mode, at the prompt type:

doors -batch dxlfile

The built in DXL server started by the initDXLServer function cannot be used 
in batch mode. As an alternative, to emulate the built in server, you can use the 
following script modified to meet the requirements of the interface being 
written:

// batchserver.dxl
IPC ipc = server 5093
string request
/* add functions for your interface here */
while (true) {
  if (accept(ipc)){ 
    if (!recv(ipc,request)) { 
      warn "Server has disconnected" 
      break 
    } 
  }else{ 
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    warn "error accepting client connection" 
    break 
  }
  print "request: "
  print request
  print "\n"
  errors=false
  if (request=="shutdown_"){ 
    send(ipc,"done_") 
    break 
  } 
  if (request=="errors_") 
    break  
  if (request=="quit_") 
    continue
  ans = eval_ request
  if (ans=="errors in eval_ string") { 
    print "errors in request\n" 
  }
  send(ipc,"done_")
  disconnect(ipc)
}
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5 DXL API integration features
This chapter describes DXL features required by the integration engineer. They 
are omitted from the DXL Reference Manual because they are potentially 
hazardous.
This chapter contains the following topics:

• General functions

• Interprocess communications

• DXL contexts

General functions

addr_

Syntax
addr_(y)

Operation

Takes arguments of any type and returns them in any context, for example:
bool x  = addr_ 1
bool y  = addr_ 0
print x " " y "\n"

Prints true false.

Note  This function is extremely hazardous, as it allows the type 
system of DXL to be violated. Use it with care, if you must 
override DXL types.

eval_

Syntax
string eval_(string)

Operation

This function causes its parameter to be executed by the DXL interpreter, within 
a private context. Declarations made within the execution do not persist after the 
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execution is complete. The result is a string which can be set using the return_ 
function.

return_

Syntax
void return_(string)

Operation

When used within a string passed to eval_, makes its argument the result of the 
call to eval_.

evalTop_

Syntax
string evalTop_(string)

Operation

Like eval_, but executes within the outermost context of the DXL interpreter, 
thus making any declarations persist. When an evalTop_ call appears in a DXL 
script its argument is not executed until the enclosing script has finished 
executing. 
The following script produces an error:

evalTop_("int a_ = 3")
print a_

When you place a variable or function in the top context, take care to avoid 
clashes with variables in other DXL programs. The name of such a variable 
should have a prefix that is the name of the tool in which it is used, and a suffix 
of an underscore. For example, for TDS you could use TDS_IPC_.

initDXLServer

Syntax
void initDXLServer(IPC dxlsrvr)

Operation

Initializes the DXL server, using a TCP/IP socket to communicate. The IPC 
channel can be initialized by the server function.
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replyAPI

Syntax
void replyAPI(string reply)

Operation
Sends the passed string back to the DXL server. This is useful in code that is called by DXL server clients using the apiSend 
function.

setAPIClientTimeout

Syntax
void setAPIClientTimeout(int tmt)

Operation

Sets the time limit for the replyAPI function to wait for an acknowledgement 
from the DXL server.

ipcHostname

Syntax
string ipcHostname(string hostAddr)

Operation

Returns the name of the host with IP address hostAddr.

ipcAddress

Syntax
string ipcAddress(string hostName)

Operation

Returns the IP address of the host named hostName.

Interprocess communications
The following functions provide interprocess communication operations:
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server

Syntax
IPC server(int portno)

Operation

Establishes a server connection to port number portno.

client

Syntax
IPC client(int portno, 
           string host)

Operation

Establishes a client connection to IP address portno at host.

accept

Syntax
bool accept(IPC chan)

Operation

Waits for a client connection. This is used by servers.

send

Syntax
bool send(IPC chan, 
          string message)

Operation

Sends the string message down the IPC channel chan.

recv

Syntax
bool recv(IPC chan, 
       {string|Buffer} &response 
        [,int tmt])
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Operation

Waits for a message to arrive in channel chan and assigns it to string or buffer 
variable response.
The optional third argument defines a time-out, tmt seconds, for a message to 
arrive in channel chan. If tmt is zero, this function waits forever. It only works if 
the caller is connected to the channel as a client or a server.

DXL contexts
To avoid over-use of resources, every function and variable declared in DXL has 
a finite lifetime. When it is no longer being used the memory that it was allocated 
is freed. The lifetime of a variable depends on the lifetime of the context in 
which it is declared.
If you attempt to access variables and functions outside their lifetimes, the results 
are undefined, but may cause DOORS to fail. There are two types of context:

• Top context

Code included in startup.dxl or executed by the evalTop_ function is in 
the top context.

• Local context

Code run from a menu, the DXL Interaction window or a call to the eval_ 
function, runs in its own local context.

Programs run in local contexts can access names declared in the top context. A 
local context is deleted when all dialog boxes created by the program run from 
the context are closed down. A program that is run in a local context and does 
not create any dialog boxes has its resources reclaimed after it terminates.
A common mistake is shown in the following scripts.
First script:

evalTop_("DB db_");

Second script:
void callback(DBE b){ 
  ack "button pressed" 
}
db_ = create "Test DB"
DBE b = button(db_, "Fail", callback)

Third script:
show db_
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By the time the third script is run, the memory occupied by the dialog box db 
and its callback function has been freed and the behavior is undefined. To make 
these scripts work, the second script must run in the top context.

Impact on triggers

Dynamic triggers are governed by the same context rules as variables and 
functions. When you set a dynamic trigger in a DXL script, it is deleted when the 
script finishes, and you do not see its effect. There are two ways to make the 
dynamic trigger survive:

• Place it in the top context using the evalTop_ function, taking care to avoid 
name clashes. 

• When the trigger is related to a DXL dialog box, keep the dialog box open.

Consider the following script:
bool dynTrig(Trigger t){ 
    ack "closing" 
    return true 
}
trigger(module, close, 10, dynTrig)
DB db = create "test"
show db

With a formal module open, run the script. Close the formal module and the 
trigger fires. Close the test dialog box and then re-open the formal module. Run 
the script again. Close the test dialog box and then close the formal module. The 
trigger does not fire.
In the first case the trigger fired because the context of the DXL script it was 
declared in was still open. In the second case the context had been closed when 
the dialog box was closed, so the trigger was no longer present and so did not 
fire.
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6 Interactive interfacing with a complex 
external tool

This chapter describes how to build interfaces between DOORS and other tools, 
such as CASE tools or other complex packages. It contains the following topics:

• Integrating DOORS with user tools

• Integrating DOORS using DOORS URLs

• Example tool to be interfaced to DOORS

• Working with OLE objects

• Listing of tds.c

Integrating DOORS with user tools 
The powerful requirements analysis, manipulation and presentation facilities 
provided by DOORS can be exploited to an even greater extent if DOORS is 
tightly coupled to the other tools present in the user’s own environment. 
DOORS uses its extension language, DXL, to provide the basis for such links, 
together with the DOORS C API which enables users to build DXL-like 
languages around existing tools and also provides the interprocess 
communication facilities needed to establish a link with DOORS. Using the 
extension language to build an interface layer around both DOORS and user 
tools is a powerful and flexible tool linkage strategy. The strategy is shown in the 
following diagram.
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Programs are represented by boxes and code libraries by parallelograms. Light 
headed arrows between boxes are C function calls. Heavy headed arrows are IPC 
communications. Both types of call can be used to read or write data in both 
directions. The arrowhead direction indicates who initiates the call.
The left half of the diagram represents a connection to an external tool A that 
provides an API (a set of functions that can be called in to input or output data 
to or from the tool. The program DOORS A interface interfaces with tool A’s 
API and communicates with DOORS via an IPC channel. In this configuration 
the external tool is acting as a server and DOORS as its client (a DOORS active 
link).
The right half of the diagram represents tool connections where DOORS is 
expected to serve calls from the external tool (a DOORS passive link). In this 
configuration DOORS acts as the server (using the DXL server) and the external 
tool acts as the client.
Both types of link make use of the DOORS C API, as do DOORS and the 
server utilities. Most of the code required to establish a link between tools is 
written using either DXL or, in the case of an active link, a DXL-like language 
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Integrating DOORS using DOORS URLs

created for the external tool’s API (AXL). The DOORS C API supports the 
construction of this language and its interpreter.
The overall strategy for a DOORS active link is:
1. Using the DOORS C API, create a DXL-like language to interface to the 

target tool’s API. These bindings form the major part of the DOORS active 
link.

2. Create DXL scripts for execution by DOORS that implement the command 
set of the desired link. This typically involves writing DXL functions that 
send data to the external tool, and writing DXL functions that can be called 
by the external tool to send results back to DOORS.

3. Create scripts for execution in the DOORS active link (AXL scripts in this 
example) that implement the command set of the desired link.

4. Run the DOORS active link as a server process. Commands made available 
by stages 2 and 3 can now be executed from DOORS, typically through 
DXL generated menus and forms.

The overall strategy for a DOORS passive link is:
1. Determine what messages need to be sent to and from DOORS. Render 

these messages as DXL function calls.

2. Create DXL scripts that implement the bodies of the function call messages 
of Step 1. Functions to be executed on the external tool (client) side need to 
be installed as DXL extensions using the DOORS C API.

3. Link (in the C object library sense) the DOORS API to the external tool.

4. Start a DOORS DXL server to handle requests from the external tool.

To illustrate the tool linkage strategy the following section uses an example target 
application: the Toy Database Server (TDS). The example shows the 
development of both a DOORS active and a DOORS passive link.

Integrating DOORS using DOORS URLs
This section is for integrators who want to refer to DOORS resources.
A DOORS URL has the following syntax:

doors://<hostport>/?<search_specification>

• Where <hostport> is the host name and port number of the DOORS 
database server that contains the DOORS resource. For example, 
server.domain:36677. 

Note  You must provide the port number.
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• <search_specification> defines the resource. It is a comma-separated 
list of search elements. The search elements and their meanings are as 
follows:

Examples of DOORS URLs 

• A database URL. Opening a database URL causes the root of the database 
to be displayed in the database explorer.
doors://greenback.telelogic.com:36678/?version=1,prodID=0,dbid=
42a6eefc651c0e5a

Search element Meaning

dbid=<unreserved> The identifier of a database. This is mandatory in 
version 1 of the URL.

version=<version> <version> is an <unreserved> that represents the 
version of the URL syntax. The version numbering 
scheme is non-zero natural numbers from 1.
In DOORS 9.1, the version number of all DOORS 
URLs will be 1. That is:
version=1

prodID=<nat> <nat> is a <reserved> that is the decimal 
representation of a natural number.
This is used to indicate the product that generated the 
URL. Current permitted values are:

• 0 - DOORS (ERS)

• 1 - DOORS XT

container=<unreser

ved>[":"<version>]

The identifier of a container (for 
example, project, folder or document) 
within the database. Notice that this 
identifier may include version information 
where <version> ::= <unreserved>

object=<unreserved

>

The identifier of an object (within a document 
container).
In case of DOORS 9.1 URLs, the object is denoted 
by its Absolute Number attribute. For example 
object=23.
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• A project URL. Opening a project URL causes the project to be made 
current in the database explorer.
doors://greenback.telelogic.com:36678/?version=1,prodID=0,dbid=
42a6eefc651c0e5a,container=000003a3

• A folder URL. Opening a folder URL causes the folder to be made current 
in the database explorer.
doors://greenback.telelogic.com:36678/?version=1,prodID=0,dbid=
42a6eefc651c0e5a,container=0000001d

• A module URL. Opening a module URL causes the module to be opened in 
the default edit mode with the default view displayed.
doors://greenback.telelogic.com:36678/?version=1,prodID=0,dbid=
42a6eefc651c0e5a,container=0000032c

• An object URL. Opening an object URL causes the containing module to be 
opened in the default edit mode with the default view displayed and the 
specified object selected. The normal view changing rules apply if the object 
is not displayed in the view.
doors://greenback.telelogic.com:36678/?version=1,prodID=0,dbid=
42a6eefc651c0e5a,container=0000032c,object=12

Example tool to be interfaced to DOORS
TDS is a very simple table manipulation package. Tables can be created and 
deleted, and their entries created and deleted. Although a small program, it 
exercises all the major features of a more complex DOORS link program.

C API for example
The C API for TDS is for use with a DOORS active link. It is the set of C data 
structures and entry points that it provides to be called by interfacing programs.

/* 
*   Data Structures: 
*/
typedef struct Table_ Table; 
typedef struct Entry_ Entry;
struct Table_ {  
   string name;  
   Entry* es;  
   Table* next; 
   int size;  
};
struct Entry_ {  
   string key;  
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   string data;  
   Entry* next;  
};

A table of type Table is simply a linked list of entries of type Entry. All tables 
are linked together.
APIs often have exit codes defined as function results, as in this example:

#define StatusOK 0 
#define StatusBadDeleteEntry 1
#define StatusBadDeleteTable 2

The two macros below define traversal macros for the two data structures:
#define tdsDo(table,e) for (e=table->es; e != NULL; e = e->next)
#define tdsTabDo(t) for (t=AllTables; t != NULL; t = t->next)

All tables are linked and accessible from this variable:
externvar Table* AllTables;

To describe the remaining functions of the C API for TDS, the parameters of 
external function declarations are shown within #if and #endif statements.

Entry Point Use

extern Table* tdsCreate();

#if 0 
   string s; 
#endif

Creates a table with name s.

extern Entry* tdsEntry();

#if 0  
   Table* t;  
   string key;  
   bool create;  
#endif

Looks up the entry according to key in 
table t. If the entry does not exist and 
create is true then create it.

extern void tdsPut();

#if 0  
   Entry* e; 
   string data; 
#endif

Associate the string data with the entry e.
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This completes the API for TDS. The implementation of this interface is in 
$DOORSHOME/api/tdsfns.c.

Making a language like DXL

Using the interface presented in “C API for example,” on page 31, you can now 
make a language like DXL to drive the interface: a DOORS active link. From the 
basis of the core DXL language, you can add TDS specific data types and 
commands. For this exercise, the resulting language is called TXL, and the 
extension .txl is used on files containing TXL scripts.
The program $DOORSHOME/api/tds.c fully implements a DXL-like interface to 
TDS. All the DOORS C API entry points are described in “The DOORS C 
API,” on page 7. The complete source for tds.c is given in “Listing of tds.c,” on 
page 49. Extracts from this program illustrate how to build the language.

extern string tdsGet();

#if 0 
   Table* t; 
   string key; 
#endif

Returns the data for the given table t and 
key. If key does not exist, returns a null 
string.

extern int tdsDeleteEntry();

#if 0 
   Table* t; 
   string key; 
#endif

Deletes the entry specified by t and key.

extern int tdsDeleteTable();

#if 0 
   Table* t; 
#endif

Deletes the given table.

extern void tdsInfo(); A diagnostic routine.

extern void tdsInit(); An initialization routine.

extern void tdsFinish(); A final housekeeping entry point.

Entry Point Use
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Including files

After some comments, the program begins with the following include 
statements:

#include <doors/api.h>  /* API services */
#include "tds.h"  /* this file's entry points */
#include "tdsfns.h"     /* the TDS API */

The first include statement is the normal way of accessing the DOORS C API 
from within a C program. The makefile given for TDS (also in 
$DOORSHOME/api) shows one way of specifying where to find both the include 
file and the necessary API object file.

Declaring functions

After including the necessary .h files, tds.c continues with:
BEGIN_FN(tdsCreateFn,1,1) 
   P_(char*,name); 
   Table* tab;    
   END_DECLS; 
   tab = tdsCreate(name); 
   RETURN_(tab); /* return the created table */ 
END_FN

The macro BEGIN_FN takes three parameters: the name of the C function to be 
registered with the API, the number of input parameters and the number of 
results (either 0, corresponding to void, or 1).
The line P_(char*,name) specifies that the first parameter is of type char* and 
is called name. After specifying all parameters (there are no more in this 
example), you must also declare any variables to be used in the function being 
defined. END_DECLS marks the end of declarations, and is always needed. The 
body of the function calls tdsCreate with the passed name and returns the 
result. The macro RETURN_ indicates what the DXL-like function should return 
when executed, but does not return from the function. END_FN ends the 
declaration of the new DXL-like function.

Installing functions

Later in tds.c there are the following lines:
apiParse("struct Table {}; struct Entry {};");
apiInstall ("Table create (string)", 
              tdsCreateFn);

This is the second part of registering a new function for a DXL-like language. 
The first parameter of apiInstall is the prototype of the new function, which 
must match the information supplied for numbers of parameters and results 
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given to BEGIN_FN. The second parameter is the name of the function created 
using BEGIN_FN. In the DXL-like language you are building, the function is 
called create.
The function apiParse parses and runs its parameter. In this case it is the 
definition of two new data types for TXL: Table and Entry. Refer to “DXL API 
integration features,” on page 21 for more information.
The program tds.c continues by specifying many more DXL-like commands in 
this way. Effectively, it makes a link from a C function (here tdsCreate), to the 
DOORS C API’s interpreter, using an intermediate function (here 
tdsCreateFn).

Declaring and installing a for loop

Later in tds.c there is:
BEGIN_FOR_DO(tdsDoFn,Table*,tab,Entry*,scan) 
     tdsDo(tab,scan) { 
        PROCESS_DO(scan); 
    } 
END_FOR_DO

This fragment should be considered paired with the later:
apiInstall("void ::do (Entry&, Table, void)", 
                         tdsDoFn);

The macro BEGIN_FOR_DO allows you to provide a DXL-like for loop for TXL. 
Its parameters are:

• The name of the function: tdsDoFn

• The type of the parent of the loop: Table* 

• A variable in which the parent is to be placed; the parent is some variable 
from which you can initialize the loop

• The type of the elements of the loop: Entry*

• A variable in which each element in turn is to be placed

The tdsDo macro is defined in “C API for example,” on page 31.
The macro PROCESS_DO makes the currently scanned element available to the 
body of the loop.
The call to apiInstall defines a function that returns void and has three 
parameters. The first parameter is a reference type for the scanned element; the 
second parameter is the parent; the third parameter is void. The installation of a 
for loop must always be in this format.
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Main program

The final step in making a DXL-like language is the main program:
/* main.c 
 * The main program of the DXL-like  
 * language, TXL  */
#include <doors/api.h>
#include <stdio.h>
#include "tds.h"
extern char* getenv();
int main (argc, argv) 
    int argc; 
    char* argv[]; 
{
    static char path[255];
    sprintf(path,"%s/lib/txl",  
                       getenv("DOORSHOME"));
    apiMainProg(argc, argv, "TXL", ".txl", path,  
                       tdsInitAPI, tdsFinishAPI); 
    return 0; 
}
/* end of main.c */

apiMainProg has the following parameters:

• The normal C main argument, argc

• The normal C main argument, argv 

• The name of the language being built, TXL, as a string

• A default file extension, .txl, as a string

• A default search path for source and include files, path

• An initialization function (called by apiMainProg)

• A termination function (called by apiMainProg)

The file tds.c implements a small, but powerful, DXL-like language for TDS. 
The command line arguments for the language are the file names of scripts 
containing TXL programs. 

Building the object file

To build the object file on UNIX platforms, use make txl in $DOORSHOME/api; 
for Win32 platforms, see “Compiling TXL on Win32 with Microsoft Developer 
Studio,” on page 38.
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Executing a TXL script

After the object file has been created, the following TXL program can be 
executed:
Example TXL script:

void printTab (Table t) {  
    Entry e 
    print "(" (name t) ":\n" 
    for e in t do        // the tdsDoFn loop  
        print (key e) " : " (data e) "\n" 
    print ")\n"  
}
void printAll () { 
    Table t  
    for t in All do  
        printTab t  
}
void doDelete (Table t, string key) {  
    int status
    delete (t, key) 
    if (status !=StatusOK)  
        warn "no record for " key " in " (name t) 
}//doDelete
Table t = create "english2french"  
// the tdsCreateFn  function 
t["one"]      =  "un"  
t["two"]      =  "deux"  
t["three"]    =  "trois"  
t["four"]     =  "quatre"  
t["five"]     =  "cinq"  
t["six"]      =  "six"  
t["seven"]    =  "sept"  
t["eight"]    =  "huit"  
t["nine"]     =  "neuf"  
t["ten"]      =  "dix"  
print t["three"] "\n"  
print "----------\n"  
printTab t  
doDelete (t, "two")  
print "-----------\n"  
printTab t 
info

A similar script is in $DOORSHOME/lib/txl/tds.txl.
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Compiling TXL on Win32 with Microsoft Developer Studio

This section describes how to build txl.exe using Microsoft Developer 
Studio®. The executable file can be built using any C compiler and you should 
adapt these instructions for your own environment.

1. Select File > New > Project workspace, and then choose Console 
Application with the name txl in directory %DOORSHOME%/api. 
(%DOORSHOME% is the directory pointed to by HOME in your doors.ini file.) 

2. Select Insert > Files into project. Add tdsfns.c, tds.c, and main.c.

3. Select, Build > Setting > Link. In the dialog box add dxlapi.lib to the 
Object library modules field, and dxlapi.dll to the path. 

4. Select Tools > Options, then select the Directories tab. Add 
%DOORSHOME%/include to the include files directories and 
%DOORSHOME%/bin to the library files directories.

5. Press F7 to build txl.exe.

Completing the DOORS active link

Now that you have a DXL-like language for TDS, you can use it to build a 
command server for DOORS.
DXL includes IPC facilities that allow messages to be passed between DXL 
interpreters. DOORS can send messages to the TXL interpreter to be executed, 
and vice versa. This is a simple and effective example of a client/server 
architecture.
To complete the DOORS active TDS link:
1. Using the DXL library (click Tools > Edit DXL > Browse), locate the 

DOORS client for TDS. The source is in $DOORSHOME/lib/dxl/ example:

The code in apiinit.dxl initializes the TDS server; the code in 
apistart.dxl starts the TDS interaction window.

2. Run apiinit and then apistart. The DOORS/TDS Link window is 
displayed. 

It has the following buttons:

Button Function

start server Starts the TDS server as a process in an xterm or DOS 
shell.
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On UNIX, the start server button opens an xterm and executes 
$DOORSHOME/api/txl with the variable port set to the port number for the 
server. The code in $DOORSHOME/lib/txl/server.txl is then executed.
On Win32, the start server button executes $DOORSHOME/api/ txl.exe, with 
the same arguments as above.
The server uses a simple protocol. It opens up an IPC server on the named 
socket, and waits for connections from DOORS clients. DOORS makes a 
connection via the start server command, which is issued by the start server 
button. The messages sent by DOORS are implemented in the included file 
t2d.txl, which is in the same directory as server.txl.
Code in server.txl

// TDS server
IPC ipc = server port     // port is passed in by api.inc
bool debug=false          // true => diagnostic output
bool errors=false         // have we had an error?
void dprint(string s) {   // diagnostic routine 
    if (debug) print s 
}
void toDoors (string s) {  
// send message, must be acknowledged
    dprint "toDoors(" s ")\n"
    if (!send(ipc, s)) 
        unixerror "toDoors/send"
    if (!recv(ipc, s)) 
        unixerror "toDoors/recv"
    dprint "Ack: " s "\n"
    if (s!="OK") eval_ s

add current 
heading

Sends the current DOORS object heading, and the name of 
the user who created the object, to TDS for inclusion in a 
TDS table as key and data.

delete current 
heading

Sends the current DOORS object heading as a key to delete 
an entry in a TDS table.

print table Prints the TDS table, and sends each entry to DOORS for 
display in a popup window.

shutdown server Shuts down the TDS server, causing the xterm or DOS 
shell to exit.

close Closes the window.

Button Function
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}//toDoors
void done () {      
// send "done" message, no acknowledge needed
    dprint "done\n"
    if (errors) 
        // client has already disconnected 
        errors=false 
    else { 
        if (!send(ipc, "done_")) 
            unixerror "done/send" 
    }
}//done
void sendError (string mess) {    
// let DOORS know about an error
    if (errors) 
        return
    if (!send(ipc, "errors_")) 
        unixerror "error/send"
    if (!recv(ipc, s)) // the ack 
        unixerror "toDoors/recv"
    if (!send(ipc, mess)) 
        unixerror "error/send"
}//sendError
string request
string res
#include <t2d>
checkIPC ipc          
// must be provided in client specific part
print "Ready to accept commands from DOORS\n"
if (!accept ipc)  
    unixerror "unexpected failure waiting for 
                DOORS client"
while (true) { 
    if (!recv(ipc,request)) { 
        warn "DOORS has disconnected" 
        break 
    }
    dprint "request: " request "\n"
    errors=false
    if (request=="shutdown_") 
        break  // no acknowledge needed
    ans = eval_ request
    if (ans=="errors in eval_ string") { 
        print "errors in request\n" 
        done 
    }
    if (request=="shutdown_") 
        break  // no acknowledge needed 
}//while (true)
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closeDown             
// must be provided in client specific part
// tds/doors interface
#include <utils>
/* 
  data 
*/
Table doors = create "doorsTable"
/* 
  the following commands are sent by doors for execution by tds 
*/
void associate(string s1, s2) {  
    print "receiving key \"" s1 "\" with data \"" 
            s2 "\"\n"  
    doors[s1] = s2  
    done  
}
void delete(string s1) {  
    int status = delete(doors,s1) 
    print "deleting \"" s1 "\"\n"
    if (status ! = StatusOK)  
        sendError "Heading \"" s1 "\" not in table"  
    else  
        done                
        // don't do "done" if we have an error 
}
void list() {  
    Entry e  
    int i=0  
    printTab doors
    for e in doors do {  
        i++  
        toDoors "fromTds(\"" (key e) "\", \"" 
                  (data e) "\")"  
    }//for
    if (i==0) { 
        sendError "no entries" 
        return     // no done needed  
    } 
    done  
}
/* server needs these two entrypoints */
void checkIPC(IPC ipc) {  
    if (null ipc)  
        unixerror "unexpected failure creating 
                     TDS server "socket" 
}//checkIPC
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void closeDown() {  
    print "server shutdown \ n"  
}

Initializing the client

The DOORS client side of the link is initialized by apiinit.dxl, which is in 
$DOORSHOME/dxl/example/apiinit.dxl. It contains the following statement:

evalTop_ "#include <example/api.inc>"

The internal DXL evalTop_ makes any definitions available to further 
executions of DXL programs. 
Except for startup.dxl, a DXL program runs in its own private context. Refer 
to “DXL API integration features,” on page 21 for an explanation of DXL’s 
context rules. 
The file api.inc contains the following:

/* 
  DOORS API Demo 
  $DOORSHOME/lib/dxl/example/api.inc 
*/
#include <utils/unique>
IPC tdsIPC = null
string tdsName = "DOORS/TDS"
int port = 5097
string host = "127.0.0.1"
string dhome = getenv "DOORSHOME"
bool tdsDebug=false
void tdsDprint(string s) { 
    if (tdsDebug) cout << s 
}
void tdsError (string mess) { 
    tdsDprint mess 
    ack tdsName ": " mess 
    halt 
}
void ackRecv() { 
    if (!send(tdsIPC, "ack")) 
        tdsError "ackRecv_ failed" 
}
void tdsSend (string request) { 
    string response, res 
    tdsDprint ">> " request "\n"
    if (!send(tdsIPC, request))  
       // tdsSend client request 
        tdsError "tdsSend failed"
    if (request=="quit_" || request=="shutdown_") 
        return
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    while (true) { 
        if (!recv(tdsIPC, response)) 
            tdsError "recv failed" 
        tdsDprint "< " response "\n"
        if (response=="done_")  
            // computation completed 
            break
        if (response=="errors_") {  
            // error message 
            ackRecv
        if (!recv(tdsIPC, response)) 
            tdsError "recv failed" 
            tdsError "tds server failure:  " 
                       response 
        }
        res = eval_ response
        if (res=="")  
            res = "OK"
        tdsDprint "> " res "\n"
        if (!send(tdsIPC, res))  
             // need response until "done" sent 
             tdsError "tdsSend failed"
    }
}
bool connected () { 
    if (null tdsIPC) { 
        tdsIPC = client(port,host)
        if (null tdsIPC) { 
            ack "not connected yet" 
            return false 
        } 
    } 
    return true 
}
/* Dialogue box stuff */
DB TDS=null
DBE tdsB1, tdsB2, tdsB3, tdsB4, tdsB5
bool TDSIsShowing = false
void finishTDS(int status) { 
    tdsIPC = null 
}
void tdsF1(DBE dbe) { 
    if (!(null tdsIPC)) { 
        ack "server socket already exists" 
    } else{ 
        if (platform == "WIN32") { 
            if (!fileExists_(dhome "/api/txl.exe")){ 
                ack("You must first make txl.exe 
                     in $DOORSHOME/api. \nSee 
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                     the DOORS API Manual for 
                     details.") 
                return 
            }//!fileExists_
            system(dhome "/api/txl  " dhome 
                   "/lib/txl/server.txl int port = " port " ") 
        }else{ 
            if (!fileExists_(dhome "/api/txl")){ 
                ack("You must first make txl in 
                     $DOORSHOME/api. \nSee the 
                     DOORS API Manual for 
                     details.") 
                return 
            }//!fileExists_
            system("xterm -e " dhome " /api/txl  " 
                   dhome "/lib/txl/server.txl  int 
                  port = " port  " ", finishTDS) 
        } 
    }//else 
}//tdsF1
void tdsF2(DBE dbe) { 
    string h =  
           (current Object)."Object Heading" ""
    string b = (current Object)."Created By" ""
    if (connected) 
        tdsSend "associate(\"" h "\", \"" b "\")" 
}
void tdsF3(DBE dbe) { 
    string h = (current Object)."Object Heading" 
                 ""
    if (connected) 
        tdsSend "delete \"" h "\"" 
}
void tdsF4(DBE dbe) { 
    if (connected) 
        tdsSend "list" 
}
void tdsF5(DBE dbe) { 
    if (connected) { 
        tdsSend "shutdown_"  
        tdsIPC = null 
    } 
}
void closeCB(DB db){ 
    TDSIsShowing = false 
    hide db 
}
void initTDS () { 
    TDS = create "DOORS/TDS Link Control"
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    tdsB1 = button(TDS, "start server", tdsF1)
    tdsB2 = button(TDS, "add current heading", 
            tdsF2) 
    tdsB3 = button(TDS, "delete current heading", 
             tdsF3)
    tdsB4 = button(TDS, "print table", tdsF4)
    tdsB5 = button(TDS, "shutdown server", tdsF5)
    close(TDS,true, closeCB)
}
// TDS required methods  -- no acknowledge necessary
void fromTds (string key, data) { 
    ack "message from TDS (" key ", " data ")" 
}
// all installed
ack "API Demo installed"

Starting the client

The DOORS/TDS client is started with the file apistart.dxl, which contains:
if (!TDSIsShowing){ 
     initTDS 
}
TDSIsShowing = true
show TDS

Protocol

The protocol for the exchange of messages is as follows:

1. DOORS starts the server process.

2. DOORS sends a message to the TXL process running server.txl by 
calling tdsSend.

3. server.txl accepts the DOORS client.

4. If the message is quit_, tdsSend takes no further action, and server.txl 
waits for the next client.

5. If the message is shutdown_, tdsSend takes no further action, and 
server.txl exits, causing the xterm or DOS shell to exit.

6. Any other message is executed by server.txl as a TXL program. 

7. tdsSend then expects a reply. 

8. If the reply is errors_, report an error.

9. If the reply is done_, stop.

10. If the reply is anything else, execute it as a DXL program and wait for a 
further message from server.txl.
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This simple protocol allows either side to send code to the other for execution, 
but DOORS must always be the initiator. This is the main characteristic of a 
DOORS active link.
The server and client code can be reused, with minor modification, as the basis 
for any other tool server (DOORS active link).

DOORS passive link

A passive link is where the application, for example, TDS, wishes to drive 
DOORS rather than act as a server. To do this, use the DOORS C API’s services 
to drive the DXL server or its batch emulation.
The programs dxlips, dxlipf and dxlfile (described in “Using the DXL 
server,” on page 17) are examples of DOORS passive link programs; their source 
is in $DOORSHOME/api. DOORS can only reply to their messages with core DXL 
messages.

1. Run the file api2init.dxl, which is in $DOORSHOME/lib/dxl/ example.

2. To start the DXL server using TCP/IP sockets run the DXL shown in 
“Using the DXL server,” on page 17.

3. From a shell, run $DOORSHOME/bin/dxlips “reply” for TCP/IP sockets.

This causes all the headings of the first formal module in the current project to 
be printed in the shell. The definition of reply in api2init.dxl is as follows:

/* Example function used to illustrate the  
DXL server.  
*/
void reply() {  
    ack "reply" 
    Object o 
    string s 
    Module mnull
    for s in current Project do {  
        if (type module s  "Formal") {  
            m = edit(s,false)  
            break  
        }  
    }//for loop
    if (null m)    
        ack "no formal modules"  
    else  
        for o in m do  
            replyAPI "print \"" (o."Object 
                       Heading" "") "\n\"" 
}//reply
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The replyAPI function sends a message back to dxlips to be executed as a 
core DXL program.
Source of dxlips.c

/* dxlips.c */ 
/*
 Copyright (c) 1993-2000 Telelogic AB. 
 See DOORS manuals for copying conditions. 
 Copy this file to a different location before 
 modifying it. 
*/
/* 
   Use TCP/IP sockets to connect to DXL server 
   from DXL interaction window execute: 
   evalTop_ "initDXLServer server 5093"  
   to initialize server. 
*/
#include <doors/api.h>
#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#define DXLDEFPORTNO 5093
#define DXLDEFIPHOST "127.0.0.1"
extern char* getenv();
int main (argc, argv) 
    int argc; 
    char* argv[]; 
{ 
    char* portnos = getenv("DXLPORTNO");  
    /* string of portno */
    char* host = getenv("DXLIPHOST");
    unsigned short portno;
    if (argc < 2) 
        apiError("usage: dxlips \"message\"");
    if (portnos==NULL) 
        portno = DXLDEFPORTNO; 
    else 
        portno = atoi(portnos);
    if (host==NULL) 
        host = DXLDEFIPHOST;
    apiInitLibrary((char*)NULL,(char*)NULL, 
                    (char*)NULL);
    printf("portno = %d, host = %s\n",  
             portno, host);
    apiConnectSock(portno, host);
    apiSend(argv[1]);
    if (apiErrorState == DOORS_API_OK && 
         strcmp(argv[1],"shutdown_")!=0) 
        apiSend("quit_");
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    apiFinishLibrary();
    return 0; 
}
/* end of dxlips.c */

It is part of apiSend’s job to wait to see whether DOORS uses replyAPI. Refer 
to “DXL API integration features,” on page 21 for more information.

Registering methods

You can make a more useful passive link by registering methods with the 
DOORS API, which can be executed by the reply. This allows a passive link 
program to retrieve data from DOORS and manipulate it. The program 
activeIP.c is the same as dxlips.c except that it has the definition:

BEGIN_FN(myRepFn,1,0)  
    P_(char*,r);  
    END_DECLS;  
    printf("\"%s\" and again \"%s\"\n", r, r);  
END_FN

and the line:
apiInstall("void myReply(string)", myRepFn);

The file api2init.dxl also defines the function reply2, which is the same as 
reply except for the line:

replyAPI "myReply \"" (o."Object Heading") "\"".

Execute:
activeIP "reply2"

to see that data from DOORS can be extracted and manipulated by the DOORS 
passive link program activeIP.
The replyAPI function can present a possible hazard to DOORS if the client 
side of the DXL server is not expecting a reply. For example, replyAPI could 
have been accidentally executed when there is no client currently connected. For 
this reason, a time limit of 20 seconds is given for the client to respond; this time 
limit can be changed with the setAPIClientTimeout function.
The protocol between clients, the DXL server and DOORS is robust against 
errors in any of the messages. The reply3 function, installed by api2init.dxl, 
deliberately returns a bad message to the DXL client, which recovers from the 
error and prints a message, as does DOORS. To see the effect, try the following:

activeIP "reply3"

The reply4 function, installed by api2init.dxl, causes dxlips to execute a 
small script that prints today’s date. To see the effect, try  the following:

dxlips "reply4"
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All DOORS passive links should follow closely the example set in this section. 
The interface should consist of a well-defined set of commands implemented as 
DXL functions that are then called by the external tool via dxlips (or a similar 
program). This minimizes the traffic through the IPC channel and will lead to a 
cleaner interface between the tools.

Working with OLE objects
On the Win32 platform, DOORS supports OLE from DXL both as an 
automation server which can implement a DOORS passive link, and as an OLE 
client which can implement a DOORS active link. 
Refer to the DXL Reference Manual for details of these DXL features. 
For further information, reference DOORS’s Microsoft Office import and 
export tools, which provide code examples of these features, and can be found 
using the Library option in the DXL Interaction window.

Listing of tds.c
/* 
 Copyright (c) 1993-2000 Telelogic AB. 
 See DOORS manuals for copying conditions. 
 Copy this file to a different location before 
 modifying it. 
*/
/* This module implements a DXL-like language for 
   TDS. 
   TDS (Toy Database System) serves as an example 
   of how to integrate external tools with DOORS. 
*/
#include <doors/api.h>     /* API services */
#include "tds.h"   /* this file's entry points */
#include "tdsfns.h"        /* the TDS API */
/* start declaring TDS API driven functions */
BEGIN_FN(tdsCreateFn,1,1) 
    P_(char*,name); 
    Table* tab; 
    END_DECLS; 
    tab = tdsCreate(name); 
    RETURN_(tab);  /* return the created table */ 
END_FN
BEGIN_FN(tdsEntryFn,2,1) 
    P_(Table*,tab); 
    P_(char*,key); 
    Entry* e; 
    END_DECLS; 
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    e = tdsEntry(tab,key,TRUE); 
    RETURN_(e); 
END_FN
BEGIN_FN(tdsPutFn,2,0) 
    P_(Entry*, e); 
    P_(char*,data); 
    END_DECLS; 
    tdsPut(e,data); 
END_FN
BEGIN_FN(tdsGetFn,2,1) 
    P_(Table*,tab); 
    P_(char*,key); 
    char* data; 
    END_DECLS; 
    data = tdsGet(tab, key); 
    RETURN_(data); 
END_FN
BEGIN_FN(tdsGetKeyFn,1,1) 
    P_(Entry*, e); 
    END_DECLS; 
    RETURN_(e->key); 
END_FN
BEGIN_FN(tdsGetDataFn,1,1) 
    P_(Entry*, e); 
    END_DECLS; 
    RETURN_(e->data); 
END_FN
BEGIN_FN(tdsGetNameFn,1,1) 
    P_(Table*, t); 
    END_DECLS; 
    RETURN_(t->name); 
END_FN
BEGIN_FN(tdsDeleteEntryFn,2,1) 
    P_(Table*,tab); 
    P_(char*,key); 
    int status; 
    END_DECLS; 
    status = tdsDeleteEntry(tab,key); 
    RETURN_(status); 
END_FN
BEGIN_FN(tdsDeleteTableFn,1,1) 
    P_(Table*,tab); 
    int status; 
    END_DECLS; 
    status = tdsDeleteTable(tab); 
    RETURN_(status); 
END_FN
BEGIN_FN(tdsInfoFn,0,0) 
    END_DECLS; 
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    tdsInfo(); 
END_FN
BEGIN_FOR_DO(tdsDoFn,Table*,tab,Entry*,scan) 
   tdsDo(tab,scan) 
       PROCESS_DO(scan); 
END_FOR_DO
BEGIN_FOR_DO(tdsDoAllFn,Table*,tab,Table*,scan) 
   tdsTabDo(scan) 
       PROCESS_DO(scan); 
END_FOR_DO
/**********************************************
 ** tdsInitAPI
*/
global void tdsInitAPI(void) 
{ 
    tdsInit();
    /* Declare the XTC types for TDS */
    apiParse("struct Table {};  
              struct Entry {};  
               Table All=null;");
    /* Declare Status constants */
    apiParse("const int StatusOK = addr_(%d) ;", 
              StatusOK);
    apiParse("const int StatusBadDeleteEntry = 
              addr_(%d) ;", StatusBadDeleteEntry);
    apiParse("const int StatusBadDeleteTable = 
              addr_(%d) ;", StatusBadDeleteTable);
    /* Declare the API entry points */
    apiInstall("Table create (string)", 
                 tdsCreateFn);
    apiInstall("Entry ::[] (Table, string)", 
                 tdsEntryFn);
    apiInstall("void ::= (Entry, string)", 
                 tdsPutFn);
    apiInstall("string ::[] (Table,string)", 
                 tdsGetFn);
    apiInstall("string key (Entry)", 
                 tdsGetKeyFn);
    apiInstall("string data (Entry)", 
                 tdsGetDataFn);
    apiInstall("string ::* (Entry)", 
                 tdsGetDataFn);
    apiInstall("string name (Table)", 
                 tdsGetNameFn);
    apiInstall("int delete (Table,string)", 
                 tdsDeleteEntryFn);
    apiInstall("int delete (Table)", 
                 tdsDeleteTableFn);
    apiInstall("void info ()", tdsInfoFn);
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    apiInstall("void ::do (Entry&, Table, void)", 
                 tdsDoFn);
    apiInstall("void ::do (Table&, Table, void)", 
                 tdsDoAllFn);
}  /* tdsInitAPI */
/* 
  tdsFinishAPI 
*/
global void tdsFinishAPI(void) 
{ 
    tdsFinish(); 
}  /* tdsFinishAPI */
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7 Contacting support
This chapter contains the following topics:

• Contacting IBM Rational Software Support

• What to do before you contact Support

• Sending an automated problem report form

• Other information

Contacting IBM Rational Software Support
Support and information for Telelogic products is currently being transitioned 
from the Telelogic Support site to the IBM Rational Software Support site. 
During this transition phase, your product support location depends on your 
customer history.

Product support
• If you are a heritage customer, meaning you were a Telelogic customer prior 

to November 1, 2008, please visit the DOORS Support Web site.

Telelogic customers will be redirected automatically to the IBM Rational 
Software Support site after the product information has been migrated.

• If you are a new Rational customer, meaning you did not have 
Telelogic-licensed products prior to November 1, 2008, please visit the IBM 
Rational Software Support site.

What to do before you contact Support
If your site has a designated on-site support person, please contact that person 
before you contact our Support team.
To help our Support team solve your problem, please have the following 
information available:

• Your name, title, company name, e-mail address, fax number and telephone 
number.

• Your support ID and support password.

• The version and build number of DOORS that you’re running.

To get this information, run DOORS, and click Help > About DOORS.

https://support.telelogic.com/doors
http://www.ibm.com/software/rational/support/
http://www.ibm.com/software/rational/support/
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• The operating system you’re running DOORS on, for example Windows 
XP.

• What operating system your DOORS database is running on, if different.

• If you are reporting a new problem, please have a clear statement of the 
problem, including the exact text of any error messages produced by 
DOORS, your operating system, or any other tools that were running when 
the problem occurred.

• If you are calling about a problem you reported earlier, you need the original 
tracking number the Support team assigned to your problem.

• If you want, you can use the automated problem report form. For 
information, see “Sending an automated problem report form,” on page 54.

The support center on our web site is at https://support.telelogic.com.

Sending an automated problem report form
To send an automated problem report to Support:
1. Select Help > Generate Support Request.

The Telelogic Support Information dialog box is displayed with some of 
your product information automatically included.

Review the information to make sure it’s accurate.

2. From the Impact drop down list box, select the severity of the problem.

3. In the Summary box, summarize the problem.

4. In the Problem box, type a detailed description of the problem.

5. If available, attach a snapshot.

Click either DOORS Window Snapshot or Screen Snapshot, whichever is 
applicable, and select the snapshot from your machine.

6. If possible, use the buttons in the Attachment Information area to add 
video capture, system details and files.

Note  The Add Product Files button is unavailable in 
DOORS. Product information is collected and added 
automatically.

Add any relevant information to help Support resolve the problem.

7. You can either:
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• Display the information you’ve entered in a new window so that you can 
copy it. For example, you may want to add this information to someone 
else’s information. 

Click Just Text (No Email).
• Open the email to edit it before sending it to Support. 

Click Preview and Send to submit the report.

Guidelines for writing a problem report

• Be as specific as possible when you summarize the problem in the 
Summary box and when you explain the situation and provide details in the 
Problem box. For example, “The system crashed when I tried to add an 
attribute” is more helpful than “It crashed.”

• Indicate if there were any system changes, such as customizations or 
upgrades, before the problem occurred.

• If the problem is reproducible, list the specific steps to be followed in order 
to demonstrate the problem and also indicate the model you are using to 
perform the steps.

• In the problem description, include anything different or unusual that you 
observed before the problem happened.

• Make screen captures of anything that you feel will help and attach them to 
the problem report.

• Include any error messages and code samples you have related to the 
problem.

• If you have multiple unrelated questions or issues, please submit them 
separately. 

Automatic responses and recording defects

When you send the online form to Support, the customer service system 
immediately searches the Knowledge Base based on the Summary and 
Problem descriptions you entered. If there is an exact match of your problem in 
the knowledge base, the system automatically sends an email to you with a 
pointer to the most likely solution.
The problem is also automatically recorded in the defect tracking system as 
assigned to a support representative. This representative works with you to be 
certain that your problem is solved. The defect tracking system also records new 
problems with their solutions in the Knowledge Base to provide rapid assistance 
for other customers.
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Automatically generated problem reports

If your DOORS system crashes, it displays a message asking if you want to send 
a problem report about the crash to DOORS Support.
If you decide to send this generated report, the system displays the same online 
form that is available from Help > Generate Support Request. In this case, 
the form contains information about the crash condition, in addition to the 
information that is usually filled in describing your system. 
Add any more information that you can to help the Support staff identify the 
problem before you click the Preview and Send button.

Changing the email address of the problem report
If you want to send the problem to someone other than DOORS Support, for 
example to your internal support, you can change the default email address of 
the problem report.
To change the email address of the problem report:
1. Open System in the Control Panel.
2. On the Advanced tab, click Environment Variables, then click New under 

variables.

The New User Variable window is displayed

3. In Variable Name enter ILX_RECIP, the variable that controls the 
address used by the problem report.

4. In Variable Value enter the email address you want to use.

5. Click OK to add the value.
6. Click OK to save the value in the environment variables.
7. Click OK to save the value in the system properties.

Other information
For Rational software product news, events, and other information, visit the 
IBM Rational Software Web site.

http://www.ibm.com/software/rational/
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8 Notices
This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right 
may be used instead. However, it is the user's responsibility to evaluate and verify 
the operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to:  
 
IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A.  
 
For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to:  
 
IBM World Trade Asia Corporation 
Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106-0032, Japan  
 
The following paragraph does not apply to the United Kingdom or any 
other country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
Some states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 
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This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the 
purpose of enabling: (i) the exchange of information between independently 
created programs and other programs (including this one) and (ii) the mutual use 
of the information which has been exchanged, should contact:  
 
Intellectual Property Dept. for Rational Software 
IBM Corporation 
1 Rogers Street 
Cambridge, Massachusetts 02142 
U.S.A. 
 
Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
may vary. Users of this document should verify the applicable data for their 
specific environment. 
Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
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Trademarks

performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 
Additional legal notices are described in the legal_information.html file that is 
included in your software installation.

Trademarks

IBM, the IBM logo, ibm.com, Telelogic, and Telelogic DOORS are trademarks 
or registered trademarks of International Business Machines Corporation in the 
United States, other countries, or both. These and other IBM trademarked terms 
are marked on their first occurrence in this information with the appropriate 
symbol (® or ™), indicating US registered or common law trademarks owned by 
IBM at the time this information was published. Such trademarks may also be 
registered or common law trademarks in other countries. A current list of IBM 
trademarks is available on the Web at www.ibm.com/legal/copytrade.html.
Microsoft, Windows and/or other Microsoft products referenced herein are 
either trademarks or registered trademarks of Microsoft Corporation.
UNIX is a registered trademark of The Open Group in the United States and 
other countries.
Other company, product or service names may be trademarks or service marks 
of others.
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